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Purpose of this document

This document is intended to provide guidance on user processes that will enable, facilitate, and
enhance the use of ONE Mail Partnered product. This document is not meant to replace any Microsoft
Outlook documentation rather it is to be used in conjunction with such material.

This document also describes how to make the ONE Mail directory available as an address book within
Outlook 2007, 2010 and 2013. This method of accessing ONE Pages works only on computers attached
to a ONE Mail Partnered organization’s network.

Should any of the information contained within this document conflict with any signed “Schedule;” the
Schedules will be deemed to be correct.
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ONE Mail is an encrypted messaging service provided and funded by eHealth Ontario, an
agency of Ontario’s Ministry of Health and Long-Term Care. ONE Mail is available to
Ontario’s health care providers to facilitate secure electronic transmission of personal
information (PI), personal health information (PHI), and other data among participants.

Generic email vs ONE Mail

Generic emails such as a Hotmail, Yahoo or Sympatico are unprotected. Your email can be
intercepted and read by others as it moves across the public internet. Think of basic email as
you would a postcard, your information could be available to prying eyes to see. You should
never send Pl or PHI over unsecured email.

ONE Mail provides additional layers of security at the operating, technical and software levels
allowing you to safely exchange Pl and PHI over the internet. ONE Mail has built in encryption
via forced transport layer security (TLS) and continuous protection against viruses and spam
using industry leading technology. With geographically distributed data centers ONE Mail
provides premier disaster recovery capabilities.

Security and Encryption: eHealth Ontario’s ONE Mail Service requires an email gateway to
guard against advanced phishing, malware, spam, and other email-borne threats. Secure email
communications among members of the ONE Mail service is enabled by encrypting email
transmissions over eHealth Ontario’s Managed Private Network (MPN), ONE Network.

As well, ONE Mail utilizes the ONE ID, the identity and access management service, which
provides additional security. Email is dependent on an adequate degree of assurance of the
identity of the sender and recipient, using ONE ID, we require a medium level of identity
assurance for individuals involved in the transmission of personal health information.
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ONE Pages

ONE Pages is a directory service or address listing provided by eHealth Ontario for the purpose
of facilitating communication between health care professionals. It is made available to all
registered users of organizations who receive services from eHealth Ontario and is therefore
the authoritative list of individuals who can securely send and receive personal health
information through ONE Mail.

Contact information in ONE Pages includes the first and last name of the ONE Mail user,
organization, and department to which they belong, and their business email address. Note
that the department information is an optional field (which you can populate) and may not be
available for some users. ONE Pages is updated systematically twice daily to ensure contents
are current.

Depending on your organization’s configuration of ONE Mail and acceptable security practices,
ONE Pages can be accessed through your web browser at https://www.one-pages.on.ca/

ONE" Pages

| ONTARIO NETWORK FOR E-HEALTH

Jse the following form to search for individuals by name, organization or department. If you are not sure of the spelling,
wpe in the first few letters and a list of possible matches will be provided.

Select Organizations Selected Organizations

ALL Organizations

1to1 Rehab

AblelLiving Services Inc

Access Health Care Services Inc.

*Required
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Sending an email using ONE Mail and ONE Pages

Now that your organization has become a ONE Mail participating organization, you are
equipped to securely send personal and personal health information to other registered users
through ONE Mail.

To ensure your message is secure, simply send it to a recipient found in ONE Pages.
How to send a secure email

Step 1: Open ONE Pages through your web browser by going to the following
website: https://www.one-pages.on.ca/

Step 2: Select the organization where you wish to send the email and click on “>>”
button (the selected organization will appear on the Selected Organization
field). You may also search by Last Name or First Name, simple type in the
person’s name and select “ALL Organizations” in the Select Organization
field.

Step 3: Click on the “Search” button to view the list of eligible users

Frstrame |

Selected Organizations

Providence Care - Providence Healthcare
Providence Healthcare il

Psychiatric Survivors Metwork of Elgin (PSNE y
A -<{

Step 4: Select the recipient of the email

Your search returned over 100 records; the first 100 are displayed below. Please refine your search.

Click on the heading to sort results by last name, first name, organization or department.

Page: 123456780910

Organization E-mail Address
_ et
o EEE o e G ©
Bee... [
Pravid T L

: - . rovidence !
3] - Alzheimer Day Program Healthcare -owdence_on.ca ; g

e
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Step 5: To compose your email, click on the “Launch E-mail” button and compose
your message and send your message.

*Note — ensure that the email client that opens up is that of your ONE Mail
email account. To verify this information contact your local IT support.

To...
B - - Providence -@pro\fidence_on.ca Cc...

Healthcare
Bee...
) To...
o I .o e R o oo o
Bee...

Page: 123456780910

Clear Selection(s) (U Launch E-mail D
v
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Adding ONE Pages to MS Outlook

The steps below will describe how to manually configure Outlook to access ONE Pages as an
option in your address book.

Instructions are provided for Microsoft Outlook 2007, 2010, 2013 and 2016. Select the option
that applies to you.

Option 1: MS Outlook 2007

Send/Receive »
Instant Search 3
L Address Book... Ctrl+Shift=B
% Organize
[¥1 Rules and Alerts..,
Qut of Office Assistant...
Step 1: Mailbox Cleanup...
'Q Empty "Deleted ltems” Folder
SeIeCt TOOIS from the {5 Recover Deleted Items...
Outlook function bar, and Forms s

select Account Settings Macro b

Account Setti%s...
Trust Center...
LCustomize...

Options...

E-mail Scan Properties...

Scan for Threats...
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Account Settings |X|

Directories and Address Books
‘¥ou can choose a directory or address book below ko change or remowe it.

| E-mnail || Diata Files || RSS Feeds || SharePoint Lists || Internet Calendars || Published Calendarsl Address Books ]

| [CER Mew. .. | 23F Change... X Remove
Step 2: Hame Type

Select the “Address Books”
tab from the Account
Settings window and click
on the “New”

Close

Add New E-mail Account |X|

Directory or Address Book Type
You can choose the bype of directory or address book vou'd like ko add.

%Internet Directory Service (LDAP)

. Connect to an LDAP server to find and verify e-mail addresses and other
Step 3 informnation.
() dudditional Address Books
H Connect to an address book ko find and verify e-mail addresses and other
Select Internet Directory Conmectfa

Service (LDAP) radio button
from the Add New Email
Account window and click
Next button.

% Back L Mext = J [ Cancel
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Add Mew E-mail Account

Step 4:

In the Server
Information/Server Name:
field type “Idap.one-
pages.on.ca” and then click
More Settings

X

Directory Service (LDAP) Settings
ou can enter the required settings to access information in a directory service,

Server Information

Tvpe the name of the directary server your Internet service provider or system administrator
has given you.

Server Name! |Ida|3.0|1e-|:|ages.0n.ca |

Logon Informatio|

[ This server requires me ko log on

More Settings ... k

[ < Back ” Mext > ][ Cancel ]

Step 5:

Add E-mail Account

- | ) The E-mail Account you have just added will not start until you choose Exit from the File menu, and then restart Microsoft Office

If you receive the following
warning “The Email Account
you... Office Outlook.” click
OK.

Step 6:

In the Microsoft LDAP
Directory window click on
the Connection tab and in
the Display Name field type
“ONE-Pages, in the
Connection Details field
type “636” for the Port and
check the Use Secure
Sockets Layer field

*Note: If you do not receive this warning continue on to the next step.

Microsoft LDAP Directory x|

Connection | Search |

Display Name
The display name as it appears in the Address Book

[oNE-Pages

—Connection Details

Part: fs38
Lge Secure Sockets

v
Layer M

OK I Cancel Apply
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Step 7:

In the Microsoft LDAP
Directory window click on
the Search tab. Under the
Server Settings, change the
“Search timeout in
seconds:” field to 60 and
change the “Specify the
maximum number of
entries you want to return
after a successful search:”
field to 999.

Under the Search Base
select the Custom radio
button and type
“cn=users,dc=one-
pages,dc=on,dc=ca”

Click Apply and then OK

Step 8:

Click on Next

Microsoft LDAP Directory

Cu:unnectin:nn| Search |

Serwver Settings

Search timeout in secands: il

specify the maximum number of entries wou

wank ba return after a successful search: 999

Search Base

() Use Default

{E}'Cugtum: cn=users do=one-pages dc=on.doc=ca

Browsing

[ ]Enable Browsing (requires server support)

| ok || cancel || pely &

Add New E-mail Account [‘5—(

Directory Service {LDAP) Settings
You can enter the required settings ko access information in & directary service,

Server Information

Type the name of the directory server vour Internet service provider or system administrakor
has given you,

Server Name: |Idap.one-uages.on.ca |

Logon Information

[ This server requires me ko log on

More Jettings ...

< Back [ Mext >[\J I [ Cancel
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Add New E-mail Account

Congratulations!

‘You have successfully entered all the information required ko setup your
accaunt.

To close the wizard, dick Finish.

Step 9:

Then click on Finish

Step 10:

The email client should now be configured to view the ONE Pages directory. It is recommended that
you restart MS Outlook before you try and view the ONE Pages directory.

Step 11:

To view the ONE Pages directory, access your MS Outlook address book and select ONE Pages from
the address book drop down menu.

Option 2: MS Outlook 2010/2013

Follow these directions to access the ONE Mail directory (ONE Pages) through Outlook
2010/2013 desktop email software.

The screen shots below were taken from Outlook 2010, but the configuration steps are
the same for Outlook 2013.
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Step 1:
Select File

Step 2:

Select Account
Settings

Step 3:

Select Account
Settings...

Send / Receive Folder View

Developer

Inbox -

Add-Ins

Save As

Open
Print
Help

Options

[ Exit

i Save as Adobe PDF

.l_@a Save Attachments

m + At ot
| S —— |

Account Information

dewey.rahim@one-mail.on.ca
S8 Microsoft Exchange

Account Settings

Delegate Access
Give others permission to receive

items and respond on your behalf.
Download Address Book...

Download a copy of the Global
Address Book,

E'_ Manage Mobile Notifications
Setup SMS and Mobile

Motifications.

odify settings for this account,
dditional connections.

Access this account on the

bttps://mail.one-mail.on.ca

S
[;31-'(9 Add and remove accounts or change
h__e_l(isting connection settings.

Step 1:

Select the Address
Books Tab

Step 2:
Select New...

rﬁmuthlﬁng:

Directories and Address Books
Yo can chonte & directony o sddress book below o change or remose it
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Step 1:

Select Internet
Directory Service
(LDAP)

Step 2:
Select Next >

Add Mew Account

Directory or Address Book Type
‘ou can choose the type of diresctory or sddress book you'd ke to add.

@ Intemet Directory Servioe (LDAP)
Connect to &n LDAP server to find and verify &-mal addresses and
formation.

Connect to an address book to find and verify e-mad addresses and other
fermation,

Step 1:

In the Server Name
field, enter
“Ildap.one-
pages.on.ca”.

Step 2:

Select More
Settings...

If a warning appears
click on the OK
button

s
Add MNew Aooount

DiFectary Servce [LDWP) Settings
o can enber the regured seltngs b scoess nformaSon in & dnectory servioe.,

Server Information
ithe nama of the dreciory sere woor INAEANET B6NACE Drevader of SyStem admresiraind

[ This server requres me bo log on
|

Aequre Seaare Pastword Suthenbosson (SPA)

el E-masil Acoount

ﬂ You must restart Outlock for these changes to take effect.

e ]
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Step 1:

Ensure that the
Connection tab is
selected.

Step 2:

For Display Name,
enter a name such
as “ONE Mail
Directory” or “ONE
Pages.” This display
name is the text that
will show up on
Outlook’s list of
available address
books, so enter
something
meaningful for an
end user.

Step 3:

Enter “636” in Port
field.

Step 4:

Select the Use
Secure Sockets
Layer box
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Step 1:

Switch to the Search
tab.

Step 2:

Enter 60 in “Search
timeout in seconds”
field.

Step 3:

Enter 999 in “Specify
the maximum
number...” field.

Step 4:

Select the Custom
radio button and
enter
“cn=users,dc=one-
pages,dc=on,dc=ca”.

Step 5:
Click OK.

Search bmeout in seconds:

Specify the masimum number of enftries you
want to return after a successful search:

Sesrch Bass

) Use Default

@ Custom: | C=users,do=one -pages, o =on do=ca

Step 6:

Click on the Next >
button

=
Add New Account

Directory Service (LDAP) Settings
You can enter the required settings to access information in a directory service.

Server Information

Type the name of the directory server your Internet service provider or system administrator
has given you.

Server Name: |Idap.one-pages.on.m |

Logon Information

This server requires me to log on

User Mame: | |

Password: | |

[]Require Secure Password Authentication (SPA)

(ool > ) e |
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Step 7: A0 M teeeh
Click on the Finish
button T
[ e —
>
Step 8: rh.r.mﬂ'ﬁ‘elﬁngs
Back at the Account Directories and Address Bocks

. . You can choose & drectary of address book below to change or remave it
Settings window,

the new addition

| E-mad | Data Fles | RSS Feeds | SharePoint Usts | intemet Calendars | Published Calendars | Address Books

shows up in the list.

Click Close D New... 5 change... X Remove

| Mane

gE

Pages (the ONE Mad drectory)

Restart Outlook to ensure the new address directory is fully installed.
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Viewing the ONE Pages in Outlook

After adding ONE Pages (the ONE Mail directory) and restarting Outlook as described
above, the new address list is now accessible.

To view ONE Pages via the Address Book

The following instructions describe how to view ONE Pages via the Address Book

Step 1: tiook == |£-J‘

To view ONE Pages, Wefencing  Adobe FDF N 7
select Address Book 3 3 L, Y (s Re
from the main sl AT J Categaorize =
window v o] [ Move RleE Onaote | o o
hMove Tags Find
1gs from ONE Mail ‘
_+ fir|
Brded this message on J013.04/11 14:29, | §
Step 2: (14 Address Bosk Global Address List (o] B ]

| File Edit Toels

Click the down arrow

Search: Mame only @ More columns  Address Book
to pu ” down the |_Go;_ Global Address List - dewey.rahmBone-mad on.ca _.=. ced Find
deveay, rahim -

Address Book menu, Sone paress
ess Lists
and ONE Pages Type your search keywords and click 'Go ﬁ:éﬁ;fs
All Ripsesre
shows up labelled as Cﬂ_uigi‘;‘
whatever was Suggested Contacs

Adde
[ ONE Pages (the ONE Mail drectory) =

entered for the
“display name”
during configuration

ONE Mail/ONE Mail Partnered User Guide/v1.4/DOC ID 3365 17



Accessing ONE Pages while composing an email Message

Accessing ONE Pages while composing an email message can be done so in several ways.
Below are the various options in which you can use to access the ONE Pages while

composing an email.

Launch your email

Select the New E-
Mail button to
generate and new
message

Select the To... R Unttied - Message (HTML) [E=RIE—)
button m Miessage Imsert Ceptions Format Test Feview Creveloper Adobe PDF - a
=1 4 |cesen réu e ﬁl @1 §l AttachFile ¥ FollowUp - q |
:;? 5 Bz E-E- EE == Y Juucnen: 1 Hehmpotance
- A EEa Y Book Memes |kSonsture B Lowimportamee
Copboard Batic Texd I Mames Inciude Tags W Ioom
dewyr rahimiP one. msilon.ca
e |
. ]
Subject : |
E- (R AR T KIS IR S0 K A KN KB KACICE LT T KT + TR0 s L -!'4---5:..1:_._;5_@
_
Step 1: [ Select Narmes: Global Address List

In the Address Book
field, click on the
dropdown arrow and
select ONE Pages

Step 2:

In the Search field,
type in the
recipient’s name,
select the name you
are searching for and
click on the To
button

Search: | Nameonly @ More colerrs Address Book

Glchal Address List - dewey . rahimBone-mal. on.ca

dewey.rahim

Global Address Lt
|Type your search keywords and dick "Go "ﬂ,ﬁ;‘;"
Al Growps
Al Rogms
Al Lsers

Contacts
Suggested Contacts

o ONE Pages (the ONE Ml drectory)

—
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Mail Bounce Backs from Legacy Domain

How To Clear Outlook’s Autocomplete Addresses

The following instructions will provide you with guidance on how to delete all cached email

addresses. There are two options available to you.

OPTION 1

Delete one or more suggested recipients in the

Auto-Complete List

OPTION 2

Clear out the AutoComplete List (all cache
entries)

(Applies to Outlook 2007, 2010, 2013 and 2016)

Enter one or more characters in the To, Cc,
or Bcc boxes. Then in the Auto-Complete List
that appears, select the unwanted suggested
recipient by using the arrow keys or by
hovering your mouse over the name you
want to remove.

Jam

James Alvord (james@contoso.com)

James Hendergart (james@fabrikam.com)

James Seymour (james@proseware.com)

Jarmes Wittrell (james@cpandl.com)

Jarnie Campbell (jamie@treyresearch.net)

Jamie Stark (jJamie@tailspintoys.com) Py

Jamilia Band (jamilia@fabrik.com)

1.

Choose X or press Delete.

(Applies to Outlook 2007 ONLY)

1. Close MS Outlook.

2. Start Explorer and
type %APPDATA%\Microsoft\Outlook in
to the address line.

3. There you will find the Outlook.nk2 file.

4. Delete it (or move it to another folder).

5. Run MS Outlook. The cache is now
clear.

6. Outlook.nk2 file will be regenerated
automatically when you launch Outlook.

(Applies to Outlook, 2010, 2013 and 2016)

1. On the File tab, choose Options > Mail.
2. Under Send messages, choose Empty
Auto-Complete List.

v| Use Auto-Complete List to suggest names when typing in the To, Cc, and A

TIP: Once a recipient name is removed, it won't appear B lines

again in the Auto—CompIete List unless you de“beratew v| Warn me when | send a message that may be missing an attachment b

select it from your Contacts list or type the address in
3. Choose Yes to confirm you want to
empty the list.

manually. These actions will add the address to the Auto-
Complete List again. If you want to permanently remove a
recipient from your Contacts list, see delete a contact
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Anti-Virus/ Anti-Spam Features

ONE Mail provides the following Anti-Virus/Anti-SPAM protection and all email exchanged
within ONE Mail participants is scanned for spam:

Spam and virus filtering
ONE Mail applies the following tools for spam and virus filtering:

e |P reputation service

e Proofpoint uses SPF checking and DNS blacklists to identify whether a connection
address is considered a "spammer"

e Proofpoint Spam Detection technology used to filter spam

e Proofpoint F-Secure Anti-Virus is used to filter viruses

Messages inbound from the Internet

All email from the Internet destined for ONE Mail participants is scanned for spam and virus
content using the following approach:

e [P reputation service identifies whether the connection address is considered a
"spammer", if so, message is rejected
e Proofpoint Spam Detection engine scores messages:
0 If the message is scored at 100, the message gets dropped
0 If the message is scored greater than 50 and less than 100, the message header
gets tagged as “Suspect Spam” and message is delivered
e Virus infected messages are cleaned and delivered to recipient. Uncleaned messages
are deleted

Messages outbound from the Internet

All email from ONE Mail participants destined for the Internet is scanned for spam using the
following approach:

e Proofpoint Spam Detection
0 If the message is scored at 100, the message gets deleted and the sender is
notified
0 eHealth Ontario provides an override feature to allow senders to send the
message (override provided to clients on a as needed basis)

All email from ONE Mail participants destined for the Internet is scanned for virus content
using:

e Proofpoint F-Secure Anti-Virus
e [f the message is infected, it gets deleted and the client will be notified
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ONE Mail Partnered Settings

Maximum Message Size

50 Megabyte max (including attachments and SMTP protocol if applicable)
If the message size exceeds the limit, the message is deleted and notification is sent to the
sender

Maximum Number of Recipients

Inbound from Internet — unlimited number of recipients
ONE Mail Partnered — unlimited

Number of Attachments

50 attachments maximum
If the number of attachments exceeds the limit, message is deleted and notification is
sent to the sender

Number of Files in a Zipped Attachment

32 files maximum
If the number of files in a zipped attachment exceeds the limit, message is deleted and
notification is sent to the sender

Invalid or Unavailable Domain

Message will stay in the queue for 5 days

If the destination domain does not exist, delete the message and notification is sent to the
sender

If the domain exists, but does not respond to delivery requests for five days, the message
will be deleted and notification is sent to the sender

Password Protected Attachments
All password protected attachments shall be delivered without interference
Encrypted Messages

All encrypted attachments shall be delivered without interference

Sender Filtering

Every message must have a sender address
Any message received with a blank sender address is deleted without notification
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ONE Mail Termination Request

In order to remove your organization from ONE® Mail please contact us via email at
onemailinfo@ehealtontario.on.ca indicating that your organization would like to be removed
from this service.

ONE Mail Support

Contact your internal help desk or IT support contact as your first line of support. If the issue is
related to our services, your help desk or IT support contact will refer the matter over to us.
Our service desk is available 24 hours a day, seven days a week.
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Copyright Notice

Copyright © 2014, eHealth Ontario

All rights reserved

No part of this document may be reproduced in any form, including photocopying or transmission electronically to any computer, without prior
written consent of eHealth Ontario. The information contained in this document is proprietary to eHealth Ontario and may not be used or

disclosed except as expressly authorized in writing by eHealth Ontario.

Trademarks

Other product names mentioned in this document may be trademarks or registered trademarks of their respective companies and are hereby

acknowledged.
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